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INTRODUCTION 

WELCOME! 
Welcome to Kid Pix 2, an entertaining, easy to use program that lets children create with the 
computer. Kid Pix 2 is designed especially with children in mind. This means that it can be 
used with little or no adult supervision. Even the youngest user can produce amazing results. 
What's more. Kid Pix 2 drawing tools, sounds, and visual effects are so appealing that your stu­
dents will be eager to explore and use the program. 

This Teacher's Guide and the Kid Pix 2 Curriculum Disk that accompanies it provide a wealth 
of ideas, samples, ready-to-use activities, and technical tips and tricks to help you and your 
students get the most out of Kid Pix 2. 

KID PIX 2 BELONGS IN EVERY CLASSROOM 

Creativity Teachers know that art is an important part of the curriculum. Unfortunately, in 
this age of shrinking budgets and increased demands on teacher time, creative expression 
often gets short shrift. Kid Pix 2 offers opportunities for art and design projects. Brushes, 
paints, pencils, erasers, patterns, backgrounds—all are instantly available. They never spill, dry 
up, or run out before the end of the year. 

Curriculum connections Students can use the power of Kid Pix 2 tools to visualize and illus­
trate concepts and ideas in every area of your curriculum, from creating and printing alphabet 
books to developing interactive projects. 

Multimedia presentations Because Kid Pix 2 includes SlideShow, a multimedia presentation 
tool, you will find students can use Kid Pix 2 to create multimedia reports and presentations in 
content area classes like social studies or science. 

NEW IN KID PIX 2 

Those of you who have used earlier versions of Kid Pix will see some additions. 

• SlideShow available directly from the Kid Pix 2 menu 
• four printing sizes in the Macintosh and Windows versions, including a full page 

option 
• a new set of city stamps 
• new hidden pictures 
• new ColorMe pictures 

KID PIX 2 CLASSROOM FEATURES 

Kid Pix 2 has features you will find particularly valuable in the classroom. 

• Small Kids Mode prevents young children from accidentally opening menus or other 
applications. This safety feature allows students to work independently with little or no 
supervision. 

• Sound effects enhance creativity and learning. Letters and numbers are spoken out 
loud, and a Spanish language option is available. DrawMe reads aloud zany sentences 
to inspire artists. 



• Text can be placed on the screen without using the keyboard. 

• Text can be also be typed directly on a drawing or illustration, using the keyboard. This 
feature enables your students to write and illustrate their own stories on the computer. 

• Appealing, ready-made graphics come in easy to use "rubber stamp" form. 

• SlideShow, a multimedia-media tool, adds excitement to class presentations. 

• Recording capabilities are available on the Macintosh or Windows with a sound board. 

USING THIS TEACHER'S GUIDE 
This guide is intended for classroom teachers from kindergarten through high school. Many 
of the lesson plans and suggestions can be adapted for use in special programs, such as ESL, 
Special Education, and Talented and Gifted programs. As you become familiar with Kid Pix 2, 
you will think of many additional ways to use its tools and features in your classroom. We are 
interested in the ways you use Kid Pix 2. Write us. Send samples of the work your students cre­
ate. Exchange Kid Pix 2 ideas with other teachers online (see page 9). 

There are four main sections to this guide. 

I. Getting Started provides an overview of this guide, discusses classroom organization 
and computer usage, cooperative learning techniques, information for teachers of 
students with special needs, and online opportunities for Kid Pix 2. 

II. Explorations suggests ways to introduce your students to the creativity of the Tools 
and Goodies. An activity called The Treasure Hunt encourages students to explore 
the variety of tool options. The treasure hunt format allows children to discover lots 
of interesting and creative program features in a constructive and guided manner. 
They will become familiar with the program and be ready to use it more indepen­
dently and creatively for larger projects. 

III. Kid Pix 2 Curriculum introduces Kid Pix 2 as a teacher productivity tool. There are 
ideas for enhancing the curriculum by using Kid Pix 2 as a vehicle to develop both 
print and electronic teaching aids. There are suggestions for generating materials to 
be used in specific subject areas, such as social studies, math or language arts. There 
are tricks and tips describing how to use other programs with Kid Pix 2. 

This section is accompanied by the Kid Pix 2 Curriculum Disk that includes samples 
of the curriculum projects described in this section of the guide. A slide show called 
The Little Lost Paper is included on the disk as well. The step-by-step techniques used 
to create this slide show are described on pages 29-32. 

IV. Classroom Projects includes thirty-one student activities for the classroom, media 
center, or computer lab. They are categorized for whole class, small group or individ­
ual use. 

These projects are designed to foster creativity while working within the curriculum 
framework. Activities coordinate with specific subject areas, yet many are cross-cur-
ricular. See the curriculum matrix on page 6 for more details. You are the best judge 
of what your class can accomplish, so grade levels are only broadly indicated. 

Most projects require only Kid Pix 2 and a printer. Some will need crayons, paste, 
scissors. You may require more materials as you modify the activities for your own 
class. 
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/. GETTING STARTED 

EXPLORING KID PIX 2 
You will want to explore Kid Pix 2 yourself before introducing it to your class. You will discov­
er that it is a lot of fun and virtually foolproof. You can't make mistakes. This is a great part of 
the satisfaction of using Kid Pix 2. The User Manual is your complete guide to using the pro­
gram. Consult it for details. If you are a novice user, consult the manual that came with your 
computer for basic information. 

ADAPTING TO COMPUTER AVAILABILITY 
Kid Pix 2 can be used successfully in a variety of classroom and computer environments. The 
suggestions for introducing the program, class organization, time management techniques, 
and tips on project selection discussed below may help you plan computer usage more effec­
tively with your students. 

The Classroom 

You may have one or possibly two computers in your classroom. While many teachers find 
using only one or a few computers in this environment a daunting task, with some planning 
you can have a successful time of it. 

Suggestions for introducing the program 
• Introduce any new piece of software to the whole class at one time, if possible. An over­

head and LCD panel, or a large screen monitor make such introductions easier for 
everyone to see. However, if this equipment is not available, try elevating the monitor 
on a higher shelf than usual and modify student seating so everyone can get close 
enough to see. 

• Be sure to demonstrate the mouse and how to use the menus. If your students are new 
to computers, pair them up and give each pair time to alternate turns directing the cur­
sor and moving the mouse around the screen. 

• Discuss the layout of the Kid Pix 2 screen. Demonstrate how to select a tool and how to 
modify it using the options at the bottom of the screen. 

• Show the class how to draw, stamp, and erase by first selecting a tool and option and 
then by moving the mouse. 

• You will find that some students in the class have already used Kid Pix 2. This will make 
the whole experience easier. Use their expertise as peer tutors for newcomers to the pro­
gram. 

Class organization and project selection 
Think about your goals for the Kid Pix 2 projects you select. The activities in this guide are 
designated whole class, small group or individual. Whole class "demonstration" activities are 
effective for introducing skills and concepts quickly, but each student has less personal inter­
action. For students who need more intensive "hands on," and for activities that allow for 
their creativity and exploration, you may want to divide your class into small groups. And 
remember, any activity can be modified to suit your classroom and students. 



Time management 
Decide how to allocate time on the computer. First consider the activity involved. 

• Is it a formal project, possibly for a grade? If this is the case, every student or group 
must be given adequate time to do a good job. This can mean setting aside large blocks 
of time in your schedule, perhaps over several weeks. 

• Is the activity primarily exploratory? If so, a different time frame is possible. A single 
afternoon may be all that you need for students to get a taste of the activity. 

• You may decide to make some Kid Pix 2 projects part of a learning center, where stu­
dents rotate turns at the computer. 

Post a schedule or checklist near the computer so the students or aides can monitor the sched­
ule. Some teachers find placing a timer or alarm clock near the computer helps everyone have 
access to the computer. 

The Computer Lab 

Choose an activity that works well in the lab setting. Labs are an advantage if you want your 
whole class to experience an activity simultaneously. Students can compare projects and 
exchange tips and successes easily in a lab. Group projects are often a good idea because they 
reduce per-pupil time required at each computer and encourage students to work together to 
solve a problem or complete an activity. If possible, train a small group of students before the 
large group lab session, so they can act as peer tutors in the computer lab. 

It is important that students get enough time to complete their work to their satisfaction. But 
adequate time in the lab setting can be difficult to achieve. Consider trading lab time with 
another teacher over a period of weeks or a month, so your students get the concentrated 
time needed to complete a project. 

Since time is usually limited in a computer lab, it is a good idea to carry out the initial plan­
ning in the classroom. 

• Designate and organize small groups. 
• Discuss project expectations. 
• Establish a general schedule so that students can allocate their time. 

• Hand out and discuss instructions or worksheets. 

• Go over goals or special instructions for the lab session. 

With this preliminary planning, students will be ready to use their time more effectively in 
the lab. 

If possible, launch the program on the computers in the lab before the class comes in, espe­
cially if the computers are connected to a network. 

The Media Center or Library 

Some media centers have many computers, like a lab. Other libraries have only one or two 
computers. If your students are using computers in a media center, adapt the above suggestions 
for the classroom or the lab, whichever fits best. Since other classes or students may be using 
the facilities at the same time, advance planning in the classroom is especially important. 

Working in the media center may be an especially good opportunity if your students' projects 
involve research or consulting reference materials. However, be sure to discuss the projects, 
and the availability of other media resources, with the librarian or media center coordinator 
BEFORE you arrive with, or send, your students. 



Since you might send groups or individual students to the media center while you work with 
the rest of your class in the classroom, be sure your students understand both their project 
goals and the technical operation of the program clearly. 

COOPERATIVE LEARNING 
You will find many opportunities to use cooperative learning strategies in the activities in this 
guide. Students will learn from one another, both about how to manipulate the features of Kid 
Pix 2 and about the learning activity in which they are cooperatively engaged. 

Cooperative groups will foster discussion about the concepts being investigated or the tech­
niques and tools used. Sometimes this discussion gets noisy, but it strengthens your students' 
participation in the exploration and in the learning process. 

When forming pairs or teams, aim for mixed groups that include both boys and girls, differ­
ent abilities, and different ethnic groups. Make sure each student is assigned a role: recorder, 
mouse handler, designer, materials manager, encourager, reader. 

You can help your students develop good cooperative learning teams by going over ground 
rules such as taking turns, rotating leadership, fulfilling responsibilities to the group, and 
making positive rather than negative comments. 

Arrange the classroom so teams can work together. This may mean moving desks together 
into groups or setting up a schedule assigning groups to specific time slots at the computer. 

A NOTE FOR SPECIAL EDUCATORS 
Broderbund is involved in an ongoing collaboration with The Foundation for Technology 
Access, a national organization working to redefine human potential by making technology a 
regular part of the lives of people with disabilities. With the help of the Foundation, we are in 
the process of testing our software for compatibility with the most widely used adaptive 
devices and technology. Adaptive devices such as Ke:nx, HeadMaster, RevolvingDoors Cursor, 
IntelliKeys, inLarge, Touch Window, DARCI TOO, Unicorn Keyboard, Switch-Adapted Mouse, 
MAGic Deluxe, and LP-DOS Deluxe are among those involved in this testing program. 

If you have students with special needs who might benefit from alternative keyboards, single 
switch controls or other adaptive devices, you can obtain more information and a listing of 
the forty-seven affiliated Alliance for Technology Access centers by calling (415) 455-4575, or 
sending E-Mail to: ata_fta@aol.com or writing to Foundation for Technology Access: 2173 East 
Francisco Blvd., Suite L, San Rafael, CA 94901. 

ONLINE ACCESS 
If you have access to American Online, one of the nation's largest interactive computer net­
work services, Broderbund has a bulletin board for both technical support and product infor­
mation. The keyword for entering this bulletin board is Broderbund. This bulletin board 
includes a special folder called Support for Educators. Within this folder is a message board. 
We invite you to post your suggestions for using Kid Pix 2 in the classroom and read sugges­
tions posted by other teachers. 

mailto:ata_fta@aol.com


II. EXPLORATIONS 

If Kid Pix 2 is a new experience for your students, they need to do some exploring. Set up 
exploring sessions—time on the computer where students can have fun doing some directed 
activities while learning important concepts. First, encourage them to try each of the tools 
and their options. Then follow up a session of free exploration with the Switcheroo and 
Treasure Hunt activities described below. 

SWITCHEROO 
The choices under Switcheroo are fun just as they are presented. Let the class explore them on 
their own. When the students are comfortable with them, introduce some of the following 
ways of extending the use of the Switcheroo choices. 

ColorMe 

You can copy any part of a ColorMe picture. 

• First select the Magnet option I I of the 

Moving Van tool L ™ ? J . Use this option to 
draw around the portion of the picture you 
want to save. 

• Then, under the Edit menu, select "Copy." 
• Next, open a new file and "Paste" under the 

Edit menu. 

• Now you can erase unwanted parts of the pic­
ture, color the remaining parts of the picture, 
customize the picture by adding to the draw­
ing. See pages 25-27 for more tips on this 
process. 

Start your own clip art file of ColorMe pictures that you have edited. 
You can add additional pictures to your clip art file by copying, renaming and saving 
any of the Hidden Pictures (use the Eraser Tool and the ? option) that you or your stu­
dents uncover. 

Put pieces of different pictures together and see how silly you can make your new com­
posite picture. You can add stamps, too! 

See page 33 for suggestions about adapting ColorMe pictures for easier coloring, espe­
cially for younger children. 

DrawMe 

If a DrawMe is too difficult as presented, suggest using stamps to draw the picture. This 
is especially good for younger students. 

If students like only part of a DrawMe sentence, they can use an eraser to remove what 
they don't want to draw. 



Copy parts of several DrawMe sentences with the Moving Van tool, as described under 
ColorMe above. Put these parts together on another screen and make a new sentence. 
If your computer allows you to record sound, your students can type and record their 
own silly DrawMe suggestions. 

Wacky TV 

The Wacky TV segments can be copied and pasted into any Kid Pix 2 picture. Use the 
Paint Can tool to match the background of the Wacky TV segment and your own pic­
ture. Select "Play Movie" from the Switcheroo menu to start the animation. Click on 
the screen to stop the animation. 

Macintosh users can paste Quick Time movies from other programs or from a video 
camera into a Kid Pix 2 picture. Windows users can import any AVI movie that fits the 
size of the Wacky TV screen. See the User Manual for more details. 

SlideShow 

A sample slide show is included on the Kid Pix 2 Curriculum Disk which 
accompanies this School Edition of Kid Pix 2. Complete instructions for 
how the screens for this slide show were created appear on pages 29-32 of 
this Teacher's Guide. More information for you and your students about 
creating and using this wonderful multimedia feature of Kid Pix 2 can be 

found in the Animation and Slide Show Guide, the Kid Pix 2 User Manual, and many 
activities in this guide. 

Swapping Stamps 

Use the Switcheroo Menu and select "Swap Stamps." You will see all the stamp sets. 
Click on the stamp set you want. Then click OK. 

TIPS AND TRICKS: you can use any group of stamps you want at any time. 
Programs like Kid Pix 2 Fun Pack™, Kid Cuts™ and Kid Art™ add additional 
stamp sets to Kid Pix 2. 

Editing Stamps 

Let's say you want a special stamp. For example, you might want to change the face on 
the jack-o-lantern to a scary face. Choose "Edit Stamp" from the Goodies menu. Then 
change the stamp, a pixel at a time. Use the stamp in its edited form. You can always 
restore the original stamp by clicking on the restore button in the Stamp Editor. If you 
are using Kid Pix 2 on a Macintosh, you can save an edited stamp, using the instruc­
tions below. 



Saving Edited Stamps on a Macintosh 
An exciting feature of Kid Pix 2 for Macintosh allows users to save the stamps they have 
carefully edited. The original versions of the stamps will remain unchanged, while the 
revised stamps can be accessed and even revised further. Here's how: 

1. Open the Kid Pix 2 folder and select the My Stamps icon. My stamps 

2. Hold down the Option key and drag the My Stamps icon onto the desktop. This 
will create a copy of My Stamps on the desktop. Leave the Kid Pix 2 folder open. 

3. Add the student's name or initials to My Stamps so it can be identified as the ver­

sion of stamps edited by that particular student. My stamps My stamps Ann 

Be sure to add the name or initials after the words "My Stamps," because the appli­
cation will look for the words My Stamps in order to launch the application. 

4. Now launch the Kid Pix 2 program from the desktop, by double clicking on the 
individualized My Stamps Ann icon, rather than the usual way of launching the 
program from the Kid Pix 2 icon. Any stamps the student edits will now be saved 
and available if the student launches the program from the My Stamps Ann icon. 

5. My Stamps Ann can be saved to a floppy disk. This disk must be placed in the flop­
py drive of a computer that has the full Kid Pix 2 application installed, in order for 
student Ann to launch the Kid Pix 2 program and use the edited stamps. 

6. In order to use these special edited stamps at a future work session, student Ann 
must first open the Kid Pix 2 folder. Leaving the Kid Pix 2 folder open, insert the 

floppy disk containing My stamps Ann. Double click on the floppy disk icon on the 
desktop. Then double click on the My Stamps Ann icon, rather than opening the 
program in the usual way from the Kid Pix 2 icon. (If the student launches the pro­
gram directly from the Kid Pix 2 icon, only the original, unedited versions of the 
stamps will be available.) 

For students who want to save multiple versions of a single stamp (four different 
versions of the skateboarder, for example), they can save several My Stamps sets 
under different names (My Stamps Ann 1, My Stamps Ann 2, My Stamps Ann 3, 
etc.) and store all these stamp sets in a folder. 



TREASURE HUNT 
A treasure hunt format is a great way to have 
children explore all of the different tool options 
available in Kid Pix 2. Duplicate the Treasure 
Hunt activity sheets on pages 15-16. Tell your 
students to select one tool at a time, explore all 
of the options for that tool, and fill in the work­
sheet answers as they come to them. They can 
complete the worksheet by drawing the appro­
priate icons and/or writing out the instructions. 
Answers to the treasure hunt can be found 
below. However, your students may discover new 
ways to achieve similar results. Post the treasure 
hunt answers your students develop somewhere 
near the computer after all students are done, as 
a reminder for future use. 

(Answers in parentheses are for teacher use only. 
When directions are given to hold down the Option 
key on the Macintosh, Windows and DOS users 
should hold down the CTRL key.) 

DO YOU KNOW HOW TO? (Treasure Hunt Answers) 
1. Make a perfect circle? (Hold down the Shift key while you use the Oval tool.) 

2. Draw a line in rainbow colors? (Choose the ? option with the Line tool.) 

3. Splatter triangles across the screen? ( Hold down the Option key while you use the 
Splatter Paint option with the Wacky Brush tool.) 

4. Make a dot to dot picture? (Use the Dot to Dot option with the Wacky Brush tool.) 

5. Make something disappear WITHOUT using the eraser? (Color over it using the Line 
tool in a wide setting, with the color white selected.) 

6. Make snowflakes appear? Raindrops? (Use the Snowflake option with the Electric 
Mixer tool. For raindrops, hold down the Option key while using this option.) 

7. Turn your drawing into nothing but an outline? (Use the Outliner option with the 
Electric Mixer tool.) 



8. Double the size of a stamp? Triple the size? (Macintosh users: Hold down the Option 
key while you stamp. For triple size, hold down the Shift key. Hold down both Shift 
and Option to quadruple the size. DOS and Windows: to double the size of a stamp, 
hold down the CTRL key; to triple the size, hold down the CTRL and Shift keys.) 

9. Use your own name to make a line to paint? (Use the Alphabet Line option with the 
Wacky Brush tool. Select "Alphabet Text" from the Goodies menu. Type your name 
in the box that appears on the screen.) 

10. Make a rainbow colored rectangle? (Use the ? option under the Rectangle tool.) 

11. Change the colors on a stamp? (Select "Edit Stamp" under the Goodies menu. 
Change the color of a stamp by selecting a color and clicking on the spot you want to 
change.) 

12. Draw with a line that has round, not straight, edges? (Using the Line tool, go to the 
second set of options for a selection of round lines.) 

13. Draw a white rectangle that you can see through? And one you can't? (Use the 
Rectangle tool and choose the first option. For a solid rectangle, use the third 
option.) 

14. Make all your whites turn black, and all your blacks turn white? (Use the Electric 
Mixer tool with the Night and Day option.) 

15. Fuzz your picture so the edges aren't straight? (Use the Wacky Brush tool with the 
Fuzzer option. Pull the cursor over the edges you want softened.) 

16. Draw something that looks like a slinky? (Use the Wacky Brush tool with the Echoes 
option.) 

17. Draw a tree? Draw a large tree? (Use the Wacky Brush tool with the Trees option. 
Hold down the Option key for a large tree.) 

18. Make part of your drawing bigger? Smaller? (Use the Electric Mixer tool with the 
Zoom In option. Click on the portion of your picture you want to magnify.) 

19. Move something from one part of the screen to another? (Use the Moving Van tool.) 

20. Copy a stamp or drawing and paste it somewhere else? (Select the image with the 
Magnet option of the Moving Van tool. Go to "Copy" under the Edit menu. To paste 
it somewhere else, use "Paste" under the Edit menu.) 



KID PIX 2 TREASURE HUNT 

DO YOU KNOW HOW TO? 
1. Make a perfect circle? 

Tool Option 
Special instructions 

2. Draw a line in rainbow colors? 

Tool Option 
Special instructions 

3. Splatter triangles across the screen? 

Tool Option 
Special instructions 

4. Make a dot to dot picture? 
Tool Option 
Special instructions 

5. Make something disappear W I T H O U T using the eraser? 

Tool Option 
Special instructions 

6. Make snowflakes appear? Raindrops? 

Tool Option 
Special instructions 

7. Turn your drawing into nothing but an outline? 

Tool Option 
Special instructions 

8. Double the size of a stamp? Triple the size? 
Tool Option 
Special instructions 

9. Use your own name to make a line to paint? 
Tool Option 
Special instructions 
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10. Make a rainbow colored rectangle? 
Tool Option 
Special instructions 

11. Change the colors on a stamp? 
Tool Option 
Special instructions 

12. Draw with a line that has round, not straight, edges? 
Tool Option 
Special instructions 

13. Draw a white rectangle that you can see through? And one you can't? 
Tool Option 
Special instructions 

14. Make all your whites turn black, and all your blacks turn white? 
Tool Option 
Special instructions 

15. Fuzz your picture so the edges aren't straight? 
Tool Option 
Special instructions 

16. Draw something that looks like a slinky? 
Tool Option 
Special instructions 

17. Draw a tree? Draw a large tree? 
Tool Option 
Special instructions 

18. Make part of your drawing bigger? Smaller? 
Tool Option 
Special instructions 

19. Move something from one part of the screen to another? 
Tool Option 
Special instructions 

20. Copy a stamp or drawing and paste it somewhere else? 
Tool Option 
Special instructions 



///. KID PIX 2 CURRICULUM 

•

Kid Pix 2 isn't just for kids! It can also be used as a teacher produc­
tivity tool. This section is your guide to getting the most from Kid Pix 
2. It has tips and techniques for supplementing your curriculum in a 
variety of ways. There are ideas for student participation in class 
through interactive worksheets, for development of instructional 
slide shows, and for simple desktop publishing. The Kid Pix 2 
Curriculum Disk that accompanies this Teacher's Guide has onscreen 
examples to inspire you. Once you and your students get started, 
there is no limit to what you can accomplish. 

Kid Pix 2 versatility originates in the power and diversity of its drawing tools. The interactive 
potential of the program adds a new dimension to computer activities in the classroom. Take 
a look at the interactive worksheet section. 

Kid Pix 2 also can import many kinds of graphics from a variety of sources. Video clips, charts, 
graphs, and scanned images can all become part of a Kid Pix 2 creation. Imported pictures can 
then be modified, edited, colored, and embellished in Kid Pix 2 using all the drawing tools. 

Your students will get excited when they see how they can enliven reports and oral presenta­
tions with desktop publishing techniques and multimedia slide shows. 

INTERACTIVE WORKSHEETS 
Interactive worksheets completed on the computer may be no different in content from the 
pencil and paper kind. However, the presentation can be as diversified as your imagination. 
Instead of the "same old thing," opportunities to practice concepts and skills can be varied 
and more exciting to students. The primary difference is that students can choose to answer 
in a variety of ways. All of the Kid Pix 2 drawing tools can be used in this interactive learning 
mode. 

There is a second benefit of using Kid Pix 2 for instructional practice. Working on the comput­
er is also a means of practicing motor skills. "Taming" the mouse becomes a lesson in spatial 
coordination, directionality and hand-eye coordination. 

The Kid Pix 2 Curriculum Disk provided with this Teacher's Guide showcases some ideas that 
are simple and quick to produce but which add another dimension to the learning process. 
For example, several worksheets work well with lessons in attribute discrimination. The stu­
dents in the primary grades who need to work on these concepts will also benefit from 
"mouse practice." 

You don't need a lab setting to use these worksheets. They can work well on a single class­
room computer. The whole class can work from one computer, an LCD panel, or a large screen 
TV. If you have small reading or math groups, use these worksheets in a learning station. 
Because they are fun, students will want to "play" with these worksheets while they practice 
important skills and concepts. 

We hope you will use the sample worksheets on the disk as inspiration to create activities of 
your own. We also encourage you to enlist students to create interactive worksheets for one 
another. 



Installing the Kid Pix 2 Curriculum Disk 

These instructions assume that you have already installed the Kid Pix 2 program. Insert the 
disk labeled Kid Pix 2 Curriculum Disk that comes with this Teacher's Guide into the floppy 
drive of the computer (DOS users, insert Disk 1). Be sure to make a copy or back up of the Kid 
Pix 2 Curriculum Disk. 

Macintosh 
• The Macintosh disk contains two folders. One folder contains the interactive work­

sheets; the other contains the slide show. You can save these folders to your hard drive 
or you can just use the floppy disk. 

• If you drag the folder containing the slide show to your hard drive and double click on 
the slide show icon, you can use the Kid Pix 2 File menu to save it as a StandAlone slide 
show. The StandAlone version of the slide show can then be saved to a blank floppy 
disk and played on any Macintosh. 

• The Macintosh version has recorded narration along with the slide show. 

DOS 
• There are two DOS disks. Disk 1 contains the worksheets files (WKSHEET.PCX). Disk 2 

contains slide show files (FRAM.PCX) and the StandAlone slide show (LOSTPAPE.EXE). 
• You can run these files from the floppy drive or the hard drive on your computer. 
• Open Kid Pix 2. Under the Kid Pix 2 File menu, select Open to access the worksheets or 

the slide show screens. To run The Little Lost Paper slide show, insert disk 2 to the floppy 
drive. If this is your B drive, at the B:\> prompt, type LOSTPAPE.EXE and press return. 

• The DOS version has the narration for the slide show and the instructions for the work­
sheets printed on the screens. 

• DOS users will not be able to record their own voice narration directly into slide shows 
or screens they create. 

Windows 
• There is one Windows disk on which the worksheets and the slide show have been com­

pressed. To view them, you need to install the files on your hard drive. 
a. Make sure you have completely exited from Windows. 
b. You will need 10 Meg. of free disk space to install these files. 
c. Insert the Curriculum disk into the 3 1/2" drive of your computer. If this is 

your B drive, at the B:\> prompt, type INSTALL (B:\INSTALL). 
d. The default drive to which the contents of this disk will be installed is 

C:\SLIDESHO. You may change the drive letter and path if you wish to do so, or 
press Enter to continue with installation. 

e. After installation is complete, load Windows. 

f. Open Kid Pix 2. Under the Kid Pix 2 File menu, select Open to access the 
Slidesho directory. 

g. Within the Slidesho directory, the worksheet files, named WKS.BMP, may be opened 
individually. The file LLP.EXE will play the StandAlone version of the slide show. The file 
LLP.SHO (or the FRAM.BMP files) will allow you to view individual slide show screens. 

• Adding sound to Windows Kid Pix 2 screens and slide shows is possible if your computer 
has the necessary equipment. However, the resulting files are very large. As a special 
project, Windows users can read aloud the text for this slide show. 

file://B:/INSTALL
file://C:/SLIDESHO


Using Interactive Worksheets 

Begin by browsing through the Worksheet choices. 

TIPS A N D TRICKS: When you close one worksheet screen or open anoth­
er. Kid Pix 2 asks if you want to save. DON'T SAVE!! You will erase the origi­
nal. If you really want to save a particular screen, change the file name of 
the screen you have altered. If you do erase the original screen by mistake, 
use your back up disk to replace it (and then make a new back up!). 

1. Open Worksheet #10. (This worksheet was created using Kid Art™.) 

2. The task for this worksheet is matching. Ask the class to find two fish that match. 
There is more than one answer. 

TIPS A N D TRICKS: When you create worksheets of your own, it is a good 
idea to plan more than one exercise or answer per screen. This cuts down 
on the number of file changes that need to be made. Opening and closing 
files take time and slow the lesson down. 

3. Have a student volunteer point out two matching fish. The student may also choose 
how to demonstrate the answer. The options are only limited by the imagination. For 
example, 

• Pair matching fish using the Moving Van tool. 
• Draw a very fancy line around matching fish using the Wacky Brush tool. 
• Change the color of the fish using Paint Can tool. 

4. The tools your students use to interact with and "answer" worksheet exercises can be 
part of the instructional process as well. You can specify how you would like students 
to answer, to reinforce skills you are working with elsewhere in the curriculum. If the 
class is learning colors, have them draw the lines with certain colors. If they are work­
ing on numbers, have them mark answers by stamping with specific numbers. 



Directions for Interactive Worksheets 

These are the instructions for children who are using the interactive worksheets on the Kid 
Pix 2 Curriculum Disk. If you are a Macintosh user. Worksheets #l-#6 have directions print­
ed on the screen, #7-#12 have directions recorded on them. For DOS and Windows users, all 
instructions are printed on the screen. 

Worksheet #1 (Skill: drawing) 
Draw more flowers like these. 

Worksheet #2 (Skill: attribute discrimination) 
Use the Moving Van tool to drag each stamp to the appropriate category. 

Worksheet #3 (Skill: comparing, contrasting) 
Name three ways these are different. 

Worksheet #4 (Skill: following directions, attribute discrimination) 
Mark the stamps that fit each clue. Which stamp is left unmarked? 

Worksheet #5 (Skill: following directions) 
Locate the one state that fits all the clues. 

Worksheet #6 (Skill: patterns) 
Use any of the stamp sets to find stamps that will complete the patterns. 

Worksheet #7 (Skill: patterns) 
Which penguin comes next? 

Worksheet #8 (skill: associating) 
Draw a line between each person and his/her home. 

Worksheet #9 (skill: comparing, following directions) 
Circle the objects that go in the lunch box. Put an X on the objects that go in 
the trash can. 

Worksheet #10 (skill: matching) 
Match the fish. 

Worksheet #11 (skill: associating) 
Put each animal in its house. 

Worksheet #12 (skill: initial consonants) 
Find more stamps that start with these letters. 



Making Interactive Worksheets 

Interactive worksheets are easy to use both in the classroom and the lab. They are just as easy 
to make. To see how an interactive worksheet is made, open Worksheet #2, a lesson in 
attribute discrimination, distinguishing between round and straight. The procedure used to 
produce this worksheet is simple and quick. Look at the screen as you read through the steps 
that were used to create it. 

1. Open a new file in Kid Pix 2. The screen should be blank. Start each worksheet this 
way. 

2. A white background is the best way to start. A colored background can interfere, for 
example, if you also plan to have students draw lines 
using colors. 

3. Using the Line tool, draw the lines as shown. Remember: 
Hold down the Shift key to make a perfectly straight line. 

4. Stamp letters to make the words "round" and "straight," 
or use "Type Text" under the Goodies menu. 

ROUND 

STRAIGHT 

5. Now pick some stamps to go on the left side of the verti­
cal line. When you stamp, hold down the Option key on 
the Macintosh and the CTRL key for DOS or Windows. 
This makes the stamp larger and easier to see on the 
screen. 

6. This worksheet is saved as Worksheet #2. When you create a worksheet, be sure to 
save it with its own special name. 

Examine the other worksheets included with this program for other techniques you might 
want to incorporate into worksheets you create yourself. 

After your students have worked with interactive worksheets, challenge them to make some of 
their own. This kind of assignment calls for higher order reasoning skills. To start out, you 
may wish to specify the concept on which the worksheet should focus, such as matching, 
counting or distinguishing initial consonants. Students should produce an on-screen activity 
that others will readily recognize and understand. At the same time, they will demonstrate 
how well they understand the focus concept. Later, these worksheets can be used with anoth­
er class, or in another school year. 

* * ROUND 

STRAIGHT 



ENHANCING CURRICULUM WITH KID PIX 2 
Kid Pix 2 and Graphics 

Kid Pix 2 is a powerful tool for modifying graphics. Any picture or clip art that can be read as a 
PICT (Mac), a .BMP (Windows) or .PCX (DOS) file can be imported into Kid Pix 2. 

Once you have imported the graphic into Kid Pix 2, all the drawing tools can be used to modi­
fy the picture. Students can change colors, erase parts or add parts. They can combine two pic­
tures into one. For example, they can place a picture of the Empire State Building into a San 
Francisco skyline. They can experience the creative power of a graphic design program with­
out using an expensive or complicated graphics package. 

Importing graphics on the MAC 

1. Open the program that has the graphic you want. 

2. Select "Copy" under the Edit menu. 

3. Copy the graphic and "Paste" it into a Kid Pix 2 screen. See your User Manual for 
greater details. 

TIPS AND TRICKS: You can create a screen capture of any Macintosh 
screen in any program using the simultaneous key combination of 
[Command/Shift/3]. This key combination creates a PICT file on your hard 
drive which you can then import into Kid Pix 2. With the Kid Pix 2 pro­
gram open, open the PICT file you have created, and continue with step 2 
above. 

Importing graphics under Windows 

1. Go to "Open" under the File Menu. 

2. All importable files will show in the selection window. 

3. Select the picture you want. Rename your .BMP file before saving changes made in 
Kid Pix 2. See your User Manual for greater detail. 

TIPS AND TRICKS: You can create a screen capture of screens from other 
programs using the Print Screen button. Begin by opening Kid Pix 2. Then 
open the program with the image you wish to capture. With that image on 
the screen, press the Print Screen button. Now return to Kid Pix 2 and select 
"Paste" from the Edit menu. 

Importing graphics on a DOS machine 

1. Go to "Open" under the File Menu. 

2. All importable files will show in the selection window. 

3. Select the graphic you want. It will appear on the Kid Pix 2 screen. See your User 
Manual for greater details. 



TIPS AND TRICKS: Hidden Pictures are a valuable set of graphics included 
in Kid Pix 2. Just erase a Hidden Picture and then save it under another 
name. Hidden Pictures, like any clip art, can be colored and modified in 
many ways. ColorMe pictures can be similarly saved and modified or used 
as backgrounds for other projects. See pages 25-27 for more details. 

Kid Pix 2 and Curriculum Materials 

Kid Pix 2 can breathe new life into teaching aids, making resources available to your students 
electronically and even interactively. Kid Pix 2 can extend and enhance curriculum material 
you currently use. Maps, charts and tables can be imported into the program and edited. 

This map of California was imported into Kid Pix 2 from MacUSA™. Kid Pix 2 and Kid Art 
stamps were added to show different industries in the state. This kind of visual aid can ampli­
fy and emphasize both written and oral presentations. You can update social studies materials 
easily: new statistics can be added to tables or graphs; industries and products can be changed. 
MacUSA, PC Globe® and PC Globe® Maps 'N' Facts™ are just three programs that can be used 
as a source of maps, charts and tables. 

Science materials also benefit from custom made visuals. You can edit a diagram in Kid Pix 2, 
adding your own labels or vocabulary emphasis. You can add pictures to illustrate a chemical 
formula or a biology definition. 

TIPS AND TRICKS: There are many programs with visuals that you can 
edit in Kid Pix 2, including PC USA®, PC GLOBE, MacUSA, MacGLOBE™, PC 
Globe Maps W Facts, The Print Shop® Deluxe, Kid Cuts™, and Kid Art. 



Kid Pix 2 and Desktop Publishing 

You might like to introduce your students to desktop publishing. Your students can try their 
hands at electronic composition and page design in Kid Pix 2. Students can make report cov­
ers, posters, or flyers using Kid Pix 2. Classroom Projects in this Teacher's Guide that involve 
desktop publishing concepts include Campaigns, Wish You Were Here, Polls, and Alphabet 
or Number Book. 

Templates are a valuable tool in the page design process. A template is a pattern or layout that 
remains constant from screen to screen. The details within the parts of the template may 
change from screen to screen, but the general layout of the page remains the same. If you 
make a template from your basic layout, that layout can be used more than once. 

Here is how to create a template using Kid Pix 2. 

1. Create the Kid Pix 2 screen that will always serve as your starting point. This can be 
just a colored background or it might be sample journal page, but remember, it never 
changes. 

2. Save your template with a special name to identify it as a 
template, such as "poetry template." 

my Poetry 

corner 

3. Make the first picture using the poetry template, but save it 
under a different name, "poetry roses." 

•"iolttsart jBliu. my Poetry 

corner 

4. Open the poetry template again to make the next picture 
and save it under another name, "poetry tiger." 

5. Continue like this, always opening the template first and saving the picture under a 
new name. 

TIPS AND TRICKS: One source of templates are the backgrounds available 
in the ColorMes and the Hidden Pictures. See pages 25-27 for more infor­
mation about using and modifying backgrounds. 

my Poetry 

corner 



Using Kid Pix 2 With Other Equipment 

Scanners are handy tools that allow you to capture an image electronically If you have access 
to a scanner, experiment with it. Photos from books, newspapers, posters and drawings are all 
scannable. Once these items are scanned and saved to a floppy disk, they can be imported into 
Kid Pix 2 like any other graphic image. If a scanner is not available in your school, check the 
commercial copy centers in your area. Some copy stores own scanners and offer this service. 

Graphics libraries are available on both CD-ROM and floppy disks. These programs have col­
lections of pictures that can be imported and used in Kid Pix 2. Check the instructions that 
accompany individual programs. See page 22 of this guide for incorporating those pictures 
into Kid Pix 2. 

The Xap Shot camera is a source for taking photographs that you can import into Kid Pix 2. 
Field trips and special class events are effective times to use Xap Shot pictures. In addition, the 
Xap Shot can sometimes be used in place of a scanner. 

BACKGROUND BASICS 
You can develop a hie of backgrounds to use in posters, activity sheets, and instructional materi­
als. Black and white line drawings are especially useful because they can be modified and changed 
easily. Collect your backgrounds in a folder or sub-directory so they will be ready to use. 

The following paragraphs describe how you can use a background to create instructional materials. 

Opening a Background 

1. Decide what background you wish to use. ColorMes and Hidden Pictures, as well as 
many clip art programs, are drawn in black and white. Kid Art backgrounds are avail­
able in both black and white and color versions. (Windows users may be unable to 
import backgrounds from Kid Art However, the procedure remains the same for mod­
ifying backgrounds from other sources.) 

2. Go to "Open" under the File menu and select the background you have chosen. The 
background will be opened on a Kid Pix 2 screen. 

3. You can now color this background any way you want using the Paint Can and other 
Kid Pix 2 tools. If you are starting with a color background, you can change its colors 
easily using the Paint Can tool. 

Using just part of a background 

1. Click on the Moving Van tool ! n! 
and then on the Magnet option I 1 

2. Draw a box around what you want to copy. 

3. Under the Edit menu, pull down to "Copy" and release the mouse button. The part 
you wish to copy will change color briefly and then go back to the original color. 

4. Open the picture or screen into which you want to paste the copied image. 

5. Under the Edit menu, pull down to "Paste" and release the mouse button. Your 
copied picture will appear on the screen. Move your mouse around until you have 
placed the image where you want and then click once. If the image is not exactly 
where you want, use the Undo tool, and then repeat the pasting process. 



TIPS A N D TRICKS: When you use any background, make sure to select 
"Save As" and give your picture a new title. Otherwise you will overwrite 
the original background. 

Modifying part of a background to use in another picture 

1. Copy the section you want to use, following the preceding instructions. Be careful 
not to include too much extra background. 

2. Open a "New" picture and "Paste" anywhere. 

3. Use the Eraser tool and erase any extra background. Erasing may be easier if you 
enlarge and then reduce the picture. 

TIPS AND TRICKS: To enlarge a picture, click on the Electric Mixer tool 

and then the Zoom In option I . Don't enlarge more than twice. Erase 
the extra background. To reduce, click on the Electric Mixer again and then 

on the Picture In A Picture option until you are back to your origi­
nal size. Some of the larger size will still show on the screen. Erase this with 
your Eraser tool. 

4. Use the Edit menu to "Copy" and "Paste" the image you have modified into your 
original picture, into another picture, or into a new picture that you will build 
around this image. 

5. If you copy and paste a black and white picture directly into a colored picture, the 
part you paste will appear transparent on the screen. You can then color it to match 
the background using the Paint Can or other Kid Pix 2 tools. 

Erasing tricks 

1. Use the Eraser tool to erase any part of an image that you don't want. 

2. If your erasing causes breaks in any of the lines of your picture, use the thinnest line 
on the Wacky Pencil tool to reconnect them. 

3. Fill erased spots with color using the Paint Can. If the colors don't match exactly, fill 
the adjoining spaces with the same color. 

4. To insure that you will not accidentally erase any important lines or sections of your 
primary object, erase most of the background around the portion you want to copy, 
but don't get too close to the object you're copying. Now using the Paint Can tool, 
fill in the sections around your chosen object with white. When you copy and paste 
this object into another picture, everything that is colored white will appear transpar­
ent. 

5. Rather than using the Eraser tool for detail work, go over unwanted areas with the 
Wacky Pencil in white. 



TIPS AND TRICKS: When you are coloring with the Paint Can tool, all 
lines must be connected. If your color fills more space than you intended, 
go immediately to the Undo Guy and then examine your lines for breaks. 
Redraw breaks in lines with the Wacky Pencil tool. 

SAMPLE BACKGROUNDS 
Personalize a background 

Add your own touches with stamps, type, and drawing tools. For example, this Kid Art back­
ground was modified in the following ways for use in The Little Lost Paper, the slide show on 
The Kid Pix 2 Curriculum Disk. 

1. An alphabet border was added above the chalkboard by drawing a green rectangle 
and typing in letters in yellow. 

2. Posters were added by using the Rectangle tool to draw the outline and stamps to fill 
in. 

3. The chalkboard looks like it is being used by adding some typing. 

4. The bulletin board now has notices on it by using the Rectangle tool. 

5. An aquarium and microscope were added to the table using Rubber Stamps. 

6. Books were put on the desk using Rubber Stamps. 



Use backgrounds to create continuity 

You can create continuity in illustrating a story if you start with a large background and then 
modify it. Copy and enlarge only one part, pasting it into a second screen which contains a 
copy of the original background. In the picture below, the teacher in the scene on the left is 
enlarged and moved forward in the scene on the right. The second teacher and the students 
have been removed in the scene on the right. See pages 25-27 and the Kid Pix 2 Curriculum 
Disk for more details about, and samples of, editing backgrounds. 

Original Picture Second Version 

Give your students practice with backgrounds too. Have each student complete a picture, or a 
series of pictures, using one of the Kid Art Community Helpers backgrounds to start. Students 
can modify the background and then write a story about what each helper does. Bind them 
into a class book. 

Using Backgrounds for State and Country reports 

Start with a large area map. (You can import maps from programs like PC USA, MacGlobe and 
Kid Art. See page 22 for details about importing graphics.) Color the state or country you want 
to emphasize a different color. You can erase any lettering that may already be on the map 
and add your own lettering. 

Use a state or a country map as a background and add stamps to show products, places of 
interest, or geographical features. 



SLIDE SHOW: THE LITTLE LOST PAPER 

How many times do you repeat the same class procedures for your students? How many times 
do you remind your students to put names on their papers? Have Kid Pix 2 do it for you. Use 
the SlideShow option of Kid Pix 2 to create presentations that are classroom aids. Let your 
computer remind the class for you. How about "reminder shows" for the following situations: 
Playground Safety, Fire Drills, Cafeteria Etiquette. 

Included on the Kid Pix 2 Curriculum Disk that comes with this School Edition is a sample 
slide show called The Little Lost Paper. The instructions for creating it are included below to 
inspire you and your students to create your own slide shows. 

TIPS A N D TRICKS: You can save StandAlone slide shows on floppy disks. 
This means you can show them on other compatible computers, in the 
media center, at home, or at a friend's house. The computer where you run 
the slide show does not need to have the Kid Pix 2 application installed in 
order for you to play your slide show, as long as the platform (Mac, 
Windows, or DOS) you used to create it matches the platform you use to 
run it (Mac, Windows or DOS). 

If your computer has the capability to record sound, you will quickly discover that adding 
sound to a Kid Pix 2 picture or slide show significantly increases the size of the file. If you 
want to create a StandAlone slide show that can be saved to a floppy disk, you may need to 
limit the number of screens and/or limit the amount of sound you add to each screen. This is 
particularly important for DOS and Windows users. 
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Directions for Creating The Little Lost Paper 

The following directions describe how to create each of the frames in The Little Lost Paper slide 
show. You would probably not want to recreate this slide show. However, by studying the 
frames on the disk and reading about the techniques used, you will be able to understand the 
various effects you can produce using Kid Pix 2. 

In addition to Kid Pix 2, stamps and backgrounds of Kid Art enhance this project. While 
Windows users may not be able to use Kid Art backgrounds with the Windows version of Kid 
Pix 2, the techniques described will work with any background you can import into Kid Pix 2. 



ERASING TRICK: Worried about accidentally erasing part of your figure? 
After you have erased most of the lines and colors around your figure, you 
can "erase" those that are very close by filling with the Paint Can with 
white. Anything that is white will copy and paste as transparent. 

3. Enlarge the trash collector using the Zoom In option of the Electric Mixer tool. 

4. Add a white rectangle in the trash can. 

5. "Save As" Frame 6. 

1. Under the File menu select "New." The title is written using "Type Text" under the 
Goodies menu. 

2. The paper is a white rectangle with a panda stamp. 
3. The head and feet for the paper are an edited stamp, stamped separately. The arms are 

drawn using Kid Pix 2 tools. 

4. "Save As" Frame 1. 

Frame 2 
Open the Kid Art background Community, Teacher. 

1. Add a picture frame using the Rectangle tool in brown. Draw a tree and then use the 
koala stamp in the middle. 

2. Put notes on the bulletin board using the Rectangle tool. 
3. Make a long thin rectangle above the chalkboard. Type in the alphabet. 
4. Add other stamps to add interest to the room. 

5. "Save As" Frame 2. 

Frame 3 
1. Select a "New" screen. Make a desk by using a combination of rectangles. 
2. Use the paper stamp from Community, some enlarged, one not, for the papers. Edit 

the stamp to erase the black lines. 
3. Use the apple stamp, enlarged. 
4. "Save As" Frame 3. 

Frames 4 and 5 
1. Open Frame 3 and use the Wacky Pencil tool to make changes. 
2. "Save As" Frame 4. 
3. Open Frame 3 again. 

4. Add the paper by making a small white rectangle. 
5. "Save As" Frame 5. 

Frame 6 

1. Open Kid Art background, Community, Trash Collector. 

2. Copy the trash collector and paste him into a "New" screen. Erase any extra lines 
around him. 



1. Select a "New" screen. Make the dump by using various stamps and drawing tools. 

2. "Save As" Frame 7. 

1. Open Frame 2. 
2. Erase the people from the room, except for the teacher standing in the doorway. Fill in 

erased spaces with color, as necessary. 

3. "Save As" Frame 8. 
4. Copy the teacher using the Moving Van tool with the Magnet option. 

5. Paste the teacher into a "New" screen. Erase any extra lines around her. (Don't forget 
the erasing trick above!) Enlarge her using the Zoom In option of the Electric Mixer 
tool. 

6. Copy this teacher and paste her back into Frame 8. "Save." 
7. You do not need to save the screen that you used to enlarge the teacher. That was 

workspace only. 

Frame 9 
1. Open the Bus Driver background from Community in Kid Art. 
2. Change the girl's braids to black using the Paint Can. 
3. "Save As" Frame 9. 

Frame 10 
1. Open the Crossing Guard background from Community in Kid Art. 
2. Redraw the girl's hair, giving her black braids. 
3. Erase any remaining light colored hair. 
4. Fill in any colors or lines that were erased. 
5. "Save As" Frame 10. 

Frame 11 
1. Using the technique from Frame 8, copy the girl's head from Frame 2 onto a "New" screen. 

2. Make needed changes to the head (tears, braids). 

3. Enlarge, using the Zoom In option. 
4. "Save As" Frame 11. 

Frame 12 
1. Select a "New" screen. Create the display board with two large rectangles, one inside the other. 
2. Fill the outside with a solid color or pattern using the Paint Can. 
3. Draw various size rectangles inside the display board to represent papers. 
4. Add stamps and lines with the Wacky Pencil. 
5. Fill in the background of the display board using a pattern option from the Paint Can. 

6. "Save As" Frame 12. 
7. Open Airport Worker background from Community in Kid Art. 

Frame 8 



Frame 12 (continued) 

8. Change the man's suit to gray, erase his cap, and redraw his hair. Fill in the hands and 
faces with a flesh tone. Remember, any white spaces will be transparent! 

9. Erase any extra drawing around the man and the little girl. Use the erasing trick here. 

10. Copy the two figures. (Close the Kid Art screen without saving it.) 

11. Paste the two figures in front of the display board you created for Frame 12. "Save." 

Frame 13 
1. Select a "New" screen. Make a large white rectangle using the Rectangle tool. 

2. Type in the beginning of a sentence. 

3. Add a large red X with the Wacky Pencil. 

4. "Save As" Frame 13. 

Frame 14 
1. Select a "New" screen. Make a large white rectangle. 

2. Type in a name. 
3. "Save As" Frame 14. 

Frame 15 
1. Open Frame 14. 
2. Add a date. 

3. "Save As" Frame 15. 

Frame 16 
1. Open Frame 15. 
2. Shrink the paper twice using the Picture In A Picture option from the Electric Mixer 

tool. 
3. Copy the smaller paper. Close Frame 15 without saving. 
4. Open a "New" screen. 

5. Paste the small paper several times. 
6. "Save As" Frame 16. 

Frame 17 
1. Select a "New" screen. Draw the refrigerator with rectangles, using the Rectangle tool. 

Add color using the Paint Can. 

2. Add extras to the refrigerator with smaller rectangles. Add stamps and lines with the 
Wacky Pencil tool. 

3. "Save As" Frame 17. 



IV. Classroom Projects 

COLORFUL DIRECTIONS 

G R A D E S K - 4 A R T 

SKILLS 
color discrimination 
following directions 
mouse practice 
spatial discrimination 

CLASS ORGANIZATION 
whole class, individual 

PURPOSE 
The ColorMe pictures are a simple but effec­
tive way to work on listening to and follow­
ing directions. 

PREPARATION 
Choose one of the Color Me pictures. Some 
of them are easier for younger children to 
work with since the areas to color are larger 
(see Tips and Tricks). Ask the class which tool 
would be easiest to use in this exercise. The 
Paint Can seems most efficient. However, 
your students may have different ideas. 

PROCEDURE 

1. Once the pictures are on the screens, tell 
your students to listen carefully to the 
directions. You can make this exercise 
as difficult as you wish. For example, 
you may elect to say each instruction 
only once. You can give instructions 
which are very specific: "In the picture 
Dog Biscuit, color the tricycle's front 
wheel blue." Or you can be more gener­
al: "In the picture Dog Biscuit, color the 
tricycle's front wheel a primary color." 

3. After the exercise is completed, you 
may want to print the pictures for the 
class. 

2. Read from directions you have written Erase 
, here 

ahead of time. It is a good idea to write v too 
them down so that they are given 
exactly the same way each time that 
they are repeated. 

TIPS AND TRICKS: When using the 
Paint Can, solid lines determine how far 
the color will go. The paint bucket will 
always fill a totally enclosed area. If 
there is a space in a line, the color will 
continue to fill until a solid line is met. 
You can use this knowledge to "open 
up" the ColorMe pictures. 

Choose a picture. Look for small areas 
which may be difficult to fill with the 
Paint Can. Open these areas up by eras­
ing tiny parts of the boundaries with 
larger areas. For example, in Dog 
Biscuit, it takes six separate fills to color 
the tricycle frame. It takes seven, if you 
color the seat post. However, by erasing 
small bits of some lines, you can color 
the tricycle in two fills, one in front of 
the pedal and one behind. You can save 
this work for reuse by making it a tem­
plate (see page 24). 



DRAWING WITH KID PIX 2 
G R A D E S K - 8 A R T 

S K I L L S 

fine motor skills 
following directions 
visual discrimination 

C L A S S O R G A N I Z A T I O N 

individual 

P U R P O S E 

This activity demonstrates that complex 
objects can be simplified into geometric 
shapes. 

P R E P A R A T I O N 

The activities listed here are suggestions 
only. You can vary this activity using any 
shapes you want and having the end result 
be anything you want. The more creative 
you are in your original directions, the 
more creative the results will be! 

P R O C E D U R E 

1. Direct students to draw an oval on the 
screen. Then give them a short amount 
of time (five minutes or less) to turn the 
oval into an animal. They can do this 
by adding more ovals or circles, adding 
lines, coloring with the pencil or the 
Paint Can, or adding texture with the 
Wacky Brush. Give students time to 
look at each other's drawings and com­
pare them. 

2. Tell students they should take a circle 
and a square and turn them into a non­
living object. 

3. After a few of these practices, let the 
students take turns giving the direc­
tions. Instruct them that they must first 
give one, two or three basic shapes and 
then tell the other students what the 
final object should be. 

E X T E N S I O N S 

• Have students draw a squiggly line on 
their computer. Then have them 
exchange computers with the person 
next to them. Each child must now 
make an object using the squiggly line 
as a base. Instruct students to make a 
very simple line to start with and to use 
only the middle of the screen. 
Otherwise the second person could 
have an impossible task! 



ALPHABET OR 

G R A D E S K - 8 

SKILLS 
desktop publishing 
organization 
teaching 
visual design 

CLASS ORGANIZATION 
small group 

PURPOSE 
Some of the most beautifully designed and 
creatively illustrated books being produced 
today are alphabet and number books for 
young children. This activity challenges 
students' imaginations as well as their 
understanding of concepts. The tutoring 
component can be used to increase confi­
dence and self esteem. 

PREPARATION 
1. Collect and display a variety of alpha­

bet and number books for your class to 
study. Discuss how the illustrators have 
handled the task of teaching about 
numbers and letters. 

2. Divide the class into groups. Each group 
will produce either an alphabet or a 
number book. If there is time, they can 
produce both. 

PROCEDURE 
1. As a whole class, look at the collection 

of alphabet and number books you 
have assembled. Point out the ways the 
illustrators have used color, page layout, 
and other design features to create a 
coherent theme. 

2. Assign time for groups to meet and 
decide on a general theme for their book. 
The theme could relate to subject matter 
the class is studying, such as an ocean 
alphabet book or a number book featur­
ing kinds of houses. Encourage groups to 
think about the design and layout of the 
book pages they are about to create. 

NUMBER BOOKS 
A R T , LANGUAGE ARTS, MATH 

3 Have each group divide up the work, 
with each member responsible for 
designing and creating a number of 
pages. 

4. Students can use any of the Kid Pix 2 
tools and stamps to create their pic­
tures. 

5. Print out the pages and gather them 
together in a book. 

6. If you complete this project with older 
students, arrange an opportunity for 
them to share their books with younger 
students. 

O 
<* 

EXTENSIONS 
• Students can create alphabet puzzle pic­

tures. For example, a ColorMe picture 
could be modified, using stamps or 
drawing tools, so that it contains many 
objects beginning with the letter B. If 
your computer has recording capabili­
ties, record a question to accompany 
the picture. For example, "This picture 
contains ten things starting with the B 
sound. How many can you find?" 

• Puzzle pictures can be used with other 
subjects as well. Students could use Kid 
Pix 2 rubber stamps to "hide" various 
kinds of animals in a picture. The 
recorded question could ask, "How 
many mammals can you find in this 
picture? How many reptiles? 
Amphibians?" 



ART GALLERY 
G R A D E S 4 - 1 2 

SKILLS 
fine motor skills 
spatial orientation 
visual design 

CLASS ORGANIZATION 
individual 

PURPOSE 
Students create their own miniature art 
gallery filled with works of art representing 
diverse styles and subjects. 

PREPARATION 
Discuss and show your students a variety of 
art styles and subjects, including landscape, 
portrait, still life, abstract. 

PROCEDURE 

1. Students should draw rectangles of sev­
eral different sizes on the page. The rec­
tangles may overlap if they like. For 
more advanced students, make them 
shadow rectangles so they appear to be 
standing out from the wall. Draw the 
rectangles using the solid Rectangle 
option (the third one on the option 
selections). Draw a second rectangle 
directly on top of this one, shifting 
slightly to the right or left. A good tip is 
to place the cross formed by the cursor 
so that two sides of it touch two sides of 
the rectangle. Fill the parts of the first 
rectangle left showing with a soft gray 
pattern so it looks like a shadow. 

2. Students may now begin to create their 
art gallery by filling the rectangles with 
their own masterpieces. Instruct them 
that they must stay within the confines 
of their "canvas." 

3. Here are some suggestions about how to 
create different styles in their paintings: 

• Use a stamp at the smallest size 
and create a mini landscape 
around it. 

A R T 

Explore the Wacky Brush and 
the Electric Mixer for some 
modern art effects. 

Fill the canvas with a pattern 
from the Paint Can and put a 
design or stamp on top of it. 

4L 

TIPS AND TRICKS: 
• If students create a painting that they 

don't like, just have them put anoth­
er solid white rectangle over the top. 
A new fresh canvas, instantly! 

• Suggest that the students SAVE after 
every individual picture is completed. 

Fill the canvas from the Paint 
Can and then carefully erase a 
portion. Draw around this 
shape with the Wacky Pencil in 
the same color as the canvas. 
Now fill the shape with a sec­
ond pattern and/or color. 

Create a portrait with a mat 
around it. Using the Oval tool, 
draw an oval in the center of 
your rectangle. (It takes some 
practice to get this centered so 
make use of the Undo guy!) Fill 
the outer part of the rectangle 
with the Paint Can. Put a stamp 
in the middle of your favorite 
person. 



PERSPECTIVE 

G R A D E S 4 - 1 2 

SKILLS 
critical thinking 
spatial orientation 
visual discrimination 

CLASS ORGANIZATION 
individual 

PURPOSE 
Students practice the concept of perspective 
which they can then replicate in their own 
art work. 

PREPARATION 
Have students look outside the window and 
identify why objects far away look different 
than objects close up. Some of the things 
they might come up with are size, clarity or 
color. Point out to them that artists use 
these characteristics to give their paintings 
a feeling of depth or to make them look 
realistic. Today's lesson will explore one 
technique of creating perspective: things in 
the distance seem smaller, and things that 
are close to you appear larger. 

PROCEDURE 

1. Use the following directions to help stu­
dents duplicate the palm tree scene 
(included here). 

A. Draw a horizon line (where the 
earth meets the sky). 

B. Fill each part of the screen with 
the Paint Can, using different 
texture options. 

C . Stamp four palm trees on the 
earth part of the picture, using 
the four different sizes of 
stamps. 
DOS and 
Windows 
users only 
have 
three sizes 
available. 

ff f 

A R T 4. 
2. Discuss with students which palm tree 

appears to be closer. Why? 

3. Next, ask students to use the following 
instructions to create the mixed up 
scene included here. 

A. Draw a simple landscape of sky 
and earth. 

B. Fill each part of the screen with 
a different texture. 

C . Stamp a sun in the picture while 
holding down the Option key on 
a Macintosh. Dos and Windows 
users use the CTRL key. 

D. Stamp a tree in the foreground. 
Stamp another tree on the hori­
zon while holding down the 
Shift key. DOS and Windows 
use CTRL and Shift. 

E. Stamp a house in the middle of 
the screen. Using the same 
stamp, stamp a second house 
right next to the first, holding 
down the Option key. DOS and 
Windows use the CTRL key. 

F. Stamp a truck on the horizon. 

4. Ask students if this picture looks realis­
tic. Having them draw upon what they 
learned in steps 1 and 2, ask them how 
they think this picture could be changed 
so that it would be in perspective. 

5. Using the same stamps and sizes, ask 
students to rearrange the stamps so that 
the picture demonstrates proper per­
spective. 



TRANSPARENCIES 
G R A D E S 4 - 1 2 A R T 

SKILLS 
color discrimination 
spatial orientation 

CLASS ORGANIZATION 
individual 

PURPOSE 
Create a pleasing visual design by mixing 
the three primary colors to produce sec­
ondary colors. 

PROCEDURE 

1. Have students draw a random selection 
of ovals, circles (hold down the Option 
key while using the Oval tool; DOS and 
Windows hold down CTRL), rectangles, 
or squares (hold down the Option key 
while using the Rectangle tool). The fig­
ures should be made using the first 
option under the Oval or Rectangle tool 
so that they are transparent and the 
lines will show through. The figures 
should overlap in places but there 
should never be three overlaps, only 
two. 

2. Students should fill in the main part of 
the figures (not the overlapping parts) 
with the three primary colors—red, yel­
low, and blue—using the Paint Can. 
Have them use the colors in one col­
umn of the color palette for all of their 
selections. This will assure them of get­
ting the same brightness in all colors. 

3. Students should then fill in the overlap­
ping sections with the appropriate 
"mixed" color. For instance, where blue 
and yellow overlap, they will fill with 
green. The figures will now look like 
transparencies, laid on top of each 
other. 

4. Fill in the background with a soft gray 
color using one of the patterns under 
the Paint Can. 

EXTENSIONS 
• Leave one of the main figures white 

and fill in the overlapping color from a 
selection on the right side of the 
palette. These are lighter hues of the 
main color and appear to be the color 
mixed with white. 

• Macintosh users can experiment with 
the color wheel which is accessed by 
holding down the Option key while 
clicking on the current color. Once 
again, students should choose from the 
same range of colors for their overlap­
ping effects. If the two main colors are 
from the middle of the color wheel, 
then the overlapping color should be 
from there also. 

• The more complicated the early draw­
ing is, the more effective the final pic­
ture will be. Encourage students to use a 
variety of shapes and sizes. Main figures 
can be overlapped many times, as long 
as there is not an overlapping of three 
figures in the same place! (Mixing three 
colors would give you black or an ugly 
brown!) 

• Have students try using patterns to fill 
in their shapes. The same color rules 
apply, but the patterns will give an 
entirely different look to the picture. 



SING ALONG 
GRADES K -4 

SKILLS 
drawing 
group cooperation 
singing 

CLASS ORGANIZATION 
whole class, small group 

PURPOSE 
Encourage musical appreciation and artistic 
expression. 

PREPARATION 
Gather a collection of songs appropriate to 
the age group of your class that lend them­
selves to both illustration and community 
singing. "Itsy Bitsy Spider" is a good exam­
ple for younger children. You can choose 
songs that represent a particular holiday, 
like a spiritual for "Martin Luther King 
Day," "Frosty the Snowman" for the holi­
day season, or "America the Beautiful" for 
President's Day. Or let the students make 
suggestions for songs they'd like to illus­
trate. 

PROCEDURE 

1. Divide the class into groups. Each group 
should meet and decide what parts of 
the chosen song are to be illustrated, 
and which group members will illus­
trate which parts. 

2. Students create drawings to illustrate 
the songs using Kid Pix 2. 

MUSIC, ART 

3. Have them enter the lyrics onscreen 
that go with each picture using the 
Alphabet tool or the keyboard. 

4. Each group assembles their completed 
pictures into a slide show. Use the time 
sliders to make sure each slide stays on 
the screen for the appropriate time. 

5. Each group runs its slide show, singing 
through the song the first time, and 
then having the class join in. 

EXTENSIONS 
• Students with musical talents can write 

and illustrate an original song. 

• Do a "Rap" Say Along instead of a Sing 
Along, and have students illustrate and 
recite a favorite rhyme or poem. 



WHAT'S IN A NAME 

L A N G U A G E A R T S , MATH 

SKILLS 
addition 
letter identification 
organization 

CLASS ORGANIZATION 
individual 

PURPOSE 
Children identify the letters in their names 
and match the letters with objects that 
begin with those letters. They practice orga­
nizing their work and use simple addition 
skills. 

PREPARATION 
Review how to swap stamp sets under the 
Switcheroo menu. 

PROCEDURE 
1. Students stamp their name across the 

top of a Kid Pix 2 screen using the 
Alphabet tool. 

2. Have children look through all of the 
stamp sets. Each time they find a stamp 
of an object that begins with the same 
letter as one in their name, they should 
place the stamp under that letter. A stu­

dent with a name like Alexandra, for 
example, can enter the stamp for an 
object beginning with 'a' under each of 
the three 'a's in her name. 

3. When they have found as many stamps 
as they can, have students total the 
number of stamps in the column under 
each letter. They should stamp the total 
at the bottom of the column, using the 
numbers available in the Alphabet tool. 

4. Finally, add the totals from each col­
umn together and stamp the grand 
total at the bottom right of the screen. 

5. Print out the name pictures and put 
them in a display in the classroom or 
school bulletin board. 

EXTENSIONS 
• Place each of the name pictures in a 

slide show to be presented on Parents 
Night. 

• Make copies of the name pictures. Then 
cut the names into strips of individual 
letters and stamps. Use these strips as 
the basis of a class picture dictionary. 

B E T H * <SI T # 
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PICTURE DESCRIPTIONS 

G R A D E S K-4 L A N G U A G E A R T S , A R T 

SKILLS 
following directions 
using descriptive terms 

CLASS ORGANIZATION 
partners 

PURPOSE 
This activity gives children practice in both 
giving and receiving verbal directions. 

PREPARATION 
Discuss with students how to describe 
something. Emphasize using words that 
really tell another person what an object 
looks like, not just naming it. Practice 
describing different things in the classroom, 
even each other! Blindfold one student and 
have another student describe a common 
object (for instance, a pencil). Tell them 
that they cannot say what the object is used 
for, they can only describe how it looks. 

PROCEDURE 

1. Have students draw a simple picture 
using Kid Pix 2. They can make it a pic­
ture of a real object or a series of simple 
geometric shapes. 

2. Print out these pictures. 

3. Before starting the second half of this 
activity, decide with the class upon 
some ground rules. Have children be 
clear about which is right and which is 
left on their papers. Mark these direc­
tions on the computer and on their 
papers if necessary. Decide which words 
will be used for top and bottom or up 
and down. 

4. Now have children return to the com­
puters in pairs. 

5. With their original picture in hand, the 
first child will tell the second child how 
to draw their picture. They should use 
as many descriptive terms as possible 
but never show the second child the 
actual drawing. Corrections should not 
be made and the second child's drawing 
should not be commented upon until 
the activity is over. 

6. Have students compare the pictures at 
the end to see how similar they are! 

top 

b o t t o m 



SCHOOL DAY DIARY 

L A N G U A G E A R T S , ART 

SKILLS 
drawing 
organization 
record keeping 
writing 

CLASS ORGANIZATION 
whole class 

PURPOSE 
Students exercise artistic expression while 
keeping a record of what they are learning. 

PREPARATION 
Assign one student to each day of an 
upcoming month or unit of study. Have the 
designated student keep a list of what has 
been studied on his/her assigned day, and 
write a brief description of the material cov­
ered. (Younger children will need help with 
text from the teacher or teaching assistant.) 

PROCEDURE 

1. The student of the day creates a single 
frame drawing that illustrates the 
assigned day's subject matter, labeling 
each event, and entering the day and 
date at the bottom of the picture. 

2. The drawing is then placed in a slide 
show. Subsequent drawings will be cre­
ated for the following days of the week. 

3. At the end of the week, month, or unit, 
play the slide show for the entire class. 

EXTENSIONS 
• Print out an individual picture and 

copy it for students to take home to 
show their families what they have 
studied on a given day or for a week. 

• Print out pictures as you go along and 
collect them in a binder for a "hard 
copy" diary of what has been learned 
for the week/month/semester. Include 
the written notes of each participating 
student with the appropriate drawing. 

• Run the slide show in a continuous 
loop during Open House. 

OCTOBER 5.1994 

We studied insects. 

fi£ O C T O B E R 6,1994 



AT THE CROSSROADS 
L A N G U A G E A R T S , ART 

SKILLS 
divergent thinking 
interpretation 
making decisions 
writing 

CLASS ORGANIZATION 
individual or small group 

PURPOSE 
Introduce the students to branching stories 
and to the concept of decision points. 

PREPARATION 
Using a familiar story such as Little Red 
Riding Hood as an example, look for the 
point where characters make decisions. 
What kind of decisions are made? What 
would have happened if other decisions 
had been made instead? This activity can be 
used as part of a unit on folk and fairy tales. 
It works especially well with well-known 
stories, or stories with which the whole 
class is familiar. 

PROCEDURE 

1. Pick a story and discuss where the char­
acter or characters make the first impor­
tant decision. 

2. Have students, as individuals or in 
small groups, use Kid Pix 2 to create a 
story board illustrating the course of 
the story until the first decision point: 
Little Red Riding Hood tells the wolf 
where she is going. 

3. Make a different choice and continue 
the storyboard. 

4. Make an alternate decision whenever 
possible. How does the story change 
with each decision? 

5. If you are using a computer with 
recording capabilities, students can 
record a short oral book report or syn­
opsis to accompany the newly created 
storyboard. 

6. Have students print out their story-
boards and add a book report or a syn­
opsis of the original story for compari­
son. 

EXTENSION 

• Have the students compose their own 
stories, allowing for decision points and 
branching. 

• Encourage students to develop several 
different branches of the same initial 
story. Compare the conclusions of the 
stories in each branch. 

IDhere are you 
taking that |~~ 
basket? 

To Grandma's 

To the soccer 
team bake sale 

Home 

Come in 

No thank 

Hi Gram 

That didn't 

look like 

Grandma! 

The end 



PICTURE POEMS 
G R A D E S 2 - 8 L A N G U A G E A R T S , ART 

SKILLS 
creative writing 
drawing 
poetry appreciation 
visual design 

CLASS ORGANIZATION 
individual 

PURPOSE 
This activity encourages students to take a 
playful approach to poetry and drawing 
and helps break down barriers between the 
arts. 

PREPARATION 
Discuss the way various poets have used the 
arrangement of words on the page to 
heighten the impact of their poetry. The 
American poet e. e. cummings is a good 
example. Have students compose original 
poems or choose favorite poems or nursery 
rhymes to make into pictures. 

PROCEDURE 

1. Have your students use the Alphabet 
Text option under the Goodies menu to 
create the text of a poem that can be 
made into pictures reflecting the sub­
ject of the poem. For example, a poem 
about a cat could be made into the 
shape of a cat. 

2. Explain how lines of text could also be 
incorporated into a larger picture. For 
example, the line "Rub-a-dub-dub, 
three men in a tub" could be used to 
draw a line representing waves in a 
seascape. 

3. If you are using a computer with 
recording capabilities, students can 
record music or sound effects to accom­
pany their picture poems. 

4. If your computer does not have the 
capacity to record sound, have students 
choose music or make sounds of their 
own to accompany their presentation. 

EXTENSIONS 

• Print out students' picture poems and 
gather them together in a class poetry 
book. 

r u b - a - d u b " d u b 
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STORYTELLING 
L A N G U A G E A R T S , SOCIAL STUDIES, ART 

SKILLS 
drawing 
making presentations 
organization 

CLASS ORGANIZATION 
individual or small group 

PURPOSE 
Introduce the tradition of storytelling and 
oral history to the class. Acquaint students 
with the folk ways and the history of a vari­
ety of ethnic groups and cultures. Give stu­
dents experience in oral presentation and 
encourage their artistic expression by hav­
ing them create original illustrations to go 
with the stories they tell. 

PREPARATION 
Discuss storytelling with your students, giv­
ing examples of how storytellers preserved 
the history and traditions from generation 
to generation, in eras and cultures where 
there was no written history. Gather a col­
lection of folk and fairy tales from which 
the children may choose for their presenta­
tions. The length and complexity of the sto­
ries can be determined by the grade level of 
your class. 

PROCEDURE 

1. Students select the story they wish to 
retell. They should read through the 
story a time or two to make certain they 
are familiar with its content. If this is a 
group project, a leader should be desig­
nated to assign a part of the story to 
each member of the group. 

2. Next, students use Kid Pix 2 to draw pic­
tures that illustrate the story. 

3. When all of the pictures are completed, 
students should print them or put them 
in order in a slide show. Allow time for 
them to practice telling their stories, 
coordinating and supporting their 
storytelling with their drawings. 

4. Hold a storyteller's festival! Students or 
groups make their presentation to the 
class by opening the screens one frame 
at a time, or showing the illustrations as 
they tell the story. If appropriate, stu­
dents can discuss with the class what 
tradition or history of a group or cul­
ture is expressed in the story. 

EXTENSIONS 
• Students can create and illustrate an 

oral history of their own family or of an 
imaginary social group or country. 



KM PIX 2 SCRABBLE 
G R A D E S 3 - 8 L A N G U A G E A R T S 

SKILLS 
fine motor skills 
spatial orientation 
spelling 

CLASS ORGANIZATION 
partners 

PURPOSE 
Playing Scrabble reinforces reading, 
spelling, and vocabulary skills. 

PREPARATION 

1. Make a large grid as a basis for your 
Scrabble board. Do this by stamping let­
ters across the top of your screen and 
down the side. These letters are for 
spacing purposes only and will be 
erased later. 

2. Draw horizontal and vertical lines 
between each of the letters. Use the line 
tool and hold down the Shift key for 
perfectly straight lines. 

0 0 0 0 0 0 

3. Erase the letters that you have stamped. 

4. Color in a few of the squares with the 
Paint Can or a small stamp. 

5. Save this grid and make a back-up. 

6. When students use this Scrabble board, 
they should always go to "Save As" and 
rename if they want to save, or click 
N O when asked if they want to save 
changes before closing. 

o 
o 
0 
0 
0 
0 
0 
0 
0 
0 

HI 
a a. 

PROCEDURE 

1. Have students work in pairs. Let them 
play Scrabble using the Alphabet tool to 
place letters in the squares. Set up 
ground rules depending upon the age 
of the students. For instance, they 
might only be able to use spelling 
words, or nouns, or words that describe. 

2. Have each student use a different color 
for easy point totals. Give one point for 
each letter they use, and triple or dou­
ble points for letters on squares that are 
colored or have a stamp. 

3. Play can continue until it is impossible 
to put in any more words, or for a set 
time limit. 



G R A D E S 2 - 1 2 

WORD SEARCH 
L A N G U A G E A R T S 

SKILLS 
mouse practice 
patterning 
spelling 
visual discrimination 

CLASS ORGANIZATION 
individual 

PURPOSE 
Word searches help children identify words 
and spelling patterns. 

PREPARATION 

1. Use the large grid that you prepared for 
Scrabble or follow the directions in the 
Scrabble activity for making one. 

0 0 0 0 o o o 
0 
0 
0 

O
O

O
 

2. Fill in a group of words on the large 
grid. Use spelling words, vocabulary 
words or even state capitals. Have them 
go up and down, backwards, and 
straight across. Make words intercon­
nect as in Scrabble. 

3. When you have all of your words 
placed, fill in the empty boxes with ran­
dom letters until the grid is full. 

L B 
c H 1 C A G 0 

K S 
E C T 

R E 0 
s L N 

T 
1 

C 
4. Erase the grid lines by selecting a wider 

Wacky Pencil width than your original 
grid lines. Choose white under the 
color palette. Draw over your original 
lines, holding down the Option key 
while you draw. Your lines will magical­
ly erase leaving only your letters! 

5. Save this Word Search by selecting 
"Save As" and giving it a new name. Do 
not override your original large grid. 

6. Print out the list of words you used for 
each student. 

PROCEDURE 

1. Have students search for the list of 
words you have given them. 

2. They should circle the words using the 
Wacky Pencil in a different color than 
the letters themselves. 

For smaller children: Only make the 
words go from left to right to reinforce 
reading skills. 



THE DAYS OF MY LIFE 

L A N G U A G E A R T S , ART, SOCIAL STUDIES 

SKILLS 
drawing 
research 
writing 

CLASS ORGANIZATION 
individual 

PURPOSE 
This activity encourages an interest in his­
tory and develops research, writing and 
organization skills. Students prepare a time 
line Slide Show of their lives by making 
drawings that illustrate events that have 
occurred since they were born. 

PREPARATION 
Locate an assortment of reference materials 
and magazines with issues dating back over a 
decade. Alert your librarian or media specialist 
in advance of this project, to assure that ample 
materials are available for your students. 

PROCEDURE 

1. Starting with the year of their birth, 
have students make a list of the years of 
their lives. 

2. Direct them to research materials such 
as almanacs and news magazines. Have 
them pick out one event of importance 
for each year on their list. They should 

also write down a short description of 
the event and its precise date. 

3. Students draw a screen picture that 
illustrates the event chosen for each 
year. Using the Alphabet tool or the 
keyboard, have them title the picture 
and add text to the screen, describing 
the event, including its locale and date. 

4. Students then create a slide show, plac­
ing the pictures into the vans in chrono­
logical order. The completed slide shows 
can be presented to the class. 

5. When students compare their slide 
shows, notice and discuss the variety of 
"important" events chosen for each 
year. 

EXTENSION 
• Print a "hard copy" of each life history 

for students to share with family and 
friends. 

• Develop a "This is Your Life" time line 
slide show about a famous person. 

• Create a time line, electronically or in 
print, that illustrates the developments 
of an important event, such as the col­
lapse of Communism, World War I or 
II, the Age of Exploration, or the Civil 
Rights movement. 



SHAPING UP 

GRADES K - 2 

SKILLS 
drawing 
observation 

CLASS ORGANIZATION 
individual 

PURPOSE 
Help children learn to identify geometric 
shapes and identify the objects around 
them that match those shapes. 

PREPARATION 
Discuss geometric shapes with the class: cir­
cle, square, triangle, oval, rectangle. Gather 
two and three dimensional objects to pass 
around, to display, and to illustrate your 
introductory discussion. Depending on the 
age and ability of your students, create 
posters or handouts with the shapes you 
want the children to use in this activity. 

MATH, ART 
EL 

PROCEDURE 

1. Using Kid Pix 2 tools, have the children 
draw a designated shape on the Kid Pix 
2 screen. 

2. Have them then explore the Kid Pix 2 
stamps to find things that match the 
shape, and/or have them draw pictures 
of things in life that match the shape. A 
mountain, pyramid, or sailing ship for a 
triangle—a soccer ball, sun or moon for 
a circle, etc. 

3. Arrange the examples on the screen 
with the shape, then name and save the 
picture. 

4. Repeat this process with as many differ­
ent shapes as you choose. 

5. Print out the pictures and put into a 
class binder or use them to illustrate a 
"shapes" bulletin board. 

Rectangle 



COORDINATES 
JDL 

SKILLS 
eye hand coordination 
following directions 
spatial orientation 

CLASS ORGANIZATION 
individual 

PURPOSE 
Coordinates serve as the building blocks for 
higher math skills. This activity will intro­
duce children to this skill with a fun reward 
at the end. 

PREPARATION 
Prepare an on screen grid in the following 
manner. 

1. Using the Line tool with the first width 
selected, hold down the SHIFT key in 
order to make straight lines across the 
screen. Space the lines evenly down the 
screen. (Tip: put one line between each 
tool.) Make vertical lines in the same 
manner (use the option boxes at the 
bottom for spacing guides). Using an 
appropriate sized font, put letters at the 
top of each vertical line and numbers 
on each horizontal line. Make sure the 
letters and numbers are O N the lines, 
not between them. Save this grid as a 
template you can use over and over. 

2. Print out one copy of the grid. Draw a 
simple picture on it. Mark the coordi­
nates wherever the drawing touches 
two intersecting lines. Make a chart of 
these coordinates starting in a logical 
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place and following the drawing around 
as if you were doing a dot to dot. Make 
copies of these coordinates for each 
child. For example: 

1. H,14 
2. H,9 
3. G,10 

PROCEDURE 
1. Students will use the Connect-The-Dots 

option under the Wacky Brush tool. 
They will find the first pair of coordi­
nates and click on that spot. A dot will 
appear with the number 1 next to it. 
They will then click on the second set 
of coordinates and so on. 

2. When students have found all of the 
coordinates, they should switch to the 
Wacky Pencil tool and connect the 
dots. They can then color or decorate 
their drawing as they like. 

TIPS AND TRICKS: The Connect-The-
Dots option only continues numbering as 
long as you do not switch to another tool 
or stop working on the picture. This activi­
ty should be finished in one sitting. If stu­
dents accidentally exit the dot to dot 
option, have them click in an inconspicu­
ous part of the picture until they are back 
at the number they need. They can erase 
these dots later. 

Students can get rid of the grid sunound-
ing their new drawing by erasing or color­
ing over the lines with the pencil using the 
white color selection. 

flBCDEFGHIJKLIIinO 



STORY MATH a 
SKILLS 
divergent thinking 
drawing conclusions 
higher order reasoning 
writing 

CLASS ORGANIZATION 
small group, individual 

PURPOSE 
Solving story problems in math becomes 
easier when visual information is provided. 

PREPARATION 
Make up a series of Kid Pix 2 screens which 
consist of objects (stamps) that can be used 
in math problems (see illustration). 

PROCEDURE 

1. Discuss the objects on the story screen. 
Make sure the class recognizes all of the 
stamps. 

2. Have the students or groups write a 
story about the picture. 

3. Have each group or student identify 
math problems that can be derived 
from the story. 

4. Exchange stories and see what problems 
others can find from the stories. 



SET THEORY 
G R A D E S 2^8 

SKILLS 
higher order reasoning 

CLASS ORGANIZATION 
whole class, individual 

PURPOSE 
Use Kid Pix 2 to present simple concepts of 
set theory as an exercise in math and logic. 

PREPARATION 
Discuss some concepts of set theory. The 
easiest ones to start with are equivalency 
one to one correspondence and subsets. 
Use the Rectangle or the Oval tools to make 
the diagrams of the sets, or have the class 
make them. Use large shapes for the entire 
set and smaller ones for the subsets. 

PROCEDURE 
1. Present the set concept that the class 

will demonstrate. For example, show 
the relationship between a set and one 
of its subsets. 

2. Define the concept or present the rule 
for determining relationship between 
the set and subset. 

M A T H Si 
3. Have the groups or individual students 

draw the set diagram. 

4. Let them select stamps from Kid Pix 2 to 
illustrate the rule or concept. 

• example: Define the set of ani­
mals. Find the subset of all the 
birds. 

• example: Show that 2 sets are 
numerically equivalent. Pair up 
all the members in one set with 
members in the other set. 

• example: Define the set of yel­
low things. Define the set of 
fruit. Where does a banana 
belong? 

Set of flnimals 

subset or birds 



FRACTION COLUMNS ^ 
G R A D E S 3 - 8 M A T H | 2 | 3 | 

SKILLS 
patterning 
visual design 

CLASS ORGANIZATION 
whole class, individual 

PURPOSE 
Students can manipulate fraction concepts 
electronically. 

PREPARATION 
Make a screen grid following the directions 
on page 46. Save the grid for this activity. 
Then save it again as a template to use with 
other activities. 

PROCEDURE 

1. Have the students create a screen grid at 
the computer. Directions are on page 46. 

2. Demonstrate the first problem. Name 
a fraction, such as %. Tell the class to 
fill in the number of squares in the 
denominator. Then refill the number 
in the numerator with a different color, 
pattern etc. 

3. Have the students label the fractions 
using "Type Text" under the Goodies 
menu. 

4. Print the exercise, or spot check the 
screens if students are working in a lab 
setting. 

5. Assign a variety of fractions for students 
to represent visually. 

EXTENSIONS 

• You can add another dimension by 
requiring the exact placement of the 
fraction column, upper left corner etc. 
You could require vertical columns and 
horizontal rows for placement. 



GRID MATH AREAS ^ 

GRADES 4-8 MATH [ 2 p l 

SKILLS 
drawing conclusions 
spatial orientation 

CLASS ORGANIZATION 
whole class, individual 

PURPOSE 
Students will produce visual representations 
of some mathematical formulas. 

PREPARATION 

1. Make the screen grid with the direc­
tions on page 46. Save it to be used 
with this activity. Save it again as a tem­
plate to be used with other activities. 

2. Discuss the formulas for area of a rec­
tangle (LxW) and a square (SxS). Ask 
the class if anyone can explain these 
statements in words. 

PROCEDURE 

1. Have the students open the screen grid 
at the computer. If you prefer, give the 
students the directions and have them 
make the grids. 

2. Present an area problem, such as 
4x3=12. Tell the class to fill an area 3 
squares down and 4 across. Use the 
Paint Can. 

3. Decide what shape they have filled, rec­
tangle or square, and state the mathe­
matical formula for its area. 

4. Count all the filled squares. Does this 
answer equal the answer from the 
numerical formula? 

5. Repeat this process with several more 
problems, including both rectangle and 
squares. 

6. Discuss what this activity tells you 
about the area formulas and the shapes 
on the grid. 

• Why are they equal? 

• Are they always equal? 

EXTENSIONS 

• Challenge your students to show the 
area of a triangle on the grid. 

A r e a = LxW 

W =3 

L = 4 



CRITTER CATALOG 

G R A D E S K - 4 S C I E N C E , ART 

SKILLS 
drawing 
organization 
research 
writing 

CLASS ORGANIZATION 
individual or small group 

PURPOSE 
Familiarize students with the different cate­
gories of living creatures. Encourage 
research in identifying their classification 
and characteristics. 

PREPARATION 
Conduct a class discussion about how many 
different kinds of living things there are on 
the earth. Talk about how they can be 
grouped in classifications or categories. 
Assign a category to each student or g r o u p -
mammals, insects, birds, fish, reptiles, etc. 
Have research materials available that are 
appropriate to the age group of the class. 

PROCEDURE 

1. If necessary, review the process of 
switching between the different stamp 
collections under the Switcheroo menu. 

2. Give students some time to consult the 
research materials you have collected 
for examples of the creatures that are 
members of the category to which they 
have been assigned. 

3. Students should look through all the 
stamps and find the ones that fall into 
their assigned category. If there aren't 
enough examples to make a four or five 

frame slide show in their category, have 
them draw pictures to include with the 
stamps. 

4. Enlarge each stamp "critter" and place 
it on the screen. To enlarge stamps, 
hold down the OPTION and SHIFT keys 
on the Mac, the CTRL and SHIFT keys 
on the IBM, while you click on the 
mouse. 

5. Label each stamp or drawing with its 
name, using the Alphabet tool or enter­
ing the name from the keyboard. 

6. Students should also create an informa­
tion screen, using what they have 
learned from their research about the 
classification and characteristics of each 
pictured "critter." 

7. When all screens have been completed, 
create a slide show, placing the pictures 
in the Moving Vans in alphabetical or 
other presentation order. 

8. Have the student or the group design 
and create a "Critter Catalog" title 
screen to be placed at the beginning of 
the slide show, and a credit screen for 
the end of the slide show that lists the 
names of those who participated in the 
preparation of the project. 

9. Have groups or individual students run 
their slide shows for the rest of the 
class. 

EXTENSION 

• Print out the pictures and information 
sheets and assemble them into a binder 
as a reference for other classes. 



WEATHER WATCH 

G R A D E S K - 4 

SKILLS 
comparison of data 
observation 
record keeping 

CLASS ORGANIZATION 
whole class 

PURPOSE 
Studying the weather can be a fascinating 
activity that you can continue from 
September until May. Children will become 
aware of how the weather affects daily lives. 

DISCUSSION 
This activity can be a very simple recording 
of the weather observed by looking out the 
window. Or, you might want to set up 
weather stations for the children to track 
the temperature and rainfall or snow totals 
throughout the year. If you are going to take 
readings, take them at the same time each 
day. Demonstrate the need for this by ini­
tially taking readings in the morning, at 
recess, at noon, and at the end of the day. 
Show students how the temperature 
changes as the day progresses. Ask for dis­
cussion on why it would be important to 
take the temperature at the same time every 
day if you were to make a comparison chart. 

PREPARATION 
Divide a Kid Pix 2 screen into six equal 
boxes, three above and three below. Label 

S C I E N C E 

one box Monday, one Tuesday, and so on. 
In the sixth, write the current week. If you 
want, put a place for the temperature to be 
recorded every day. Be sure and put a time 
next to the temperature reading. Save this 
as a template and make a backup copy. 

PROCEDURE 
Rotate children on the computer so that 
everyone gets to do a day. 

1. Each week children should open the 
weather template and give it a new 
name (use the week's date) by going to 
"Save As." This way you will always have 
your template. If your template gets 
saved over accidentally, use the back-up 
and immediately make a new one. 

2. In the box appropriate to the current 
day, children should draw a picture 
depicting the weather. They may be as 
creative as they wish. They might have 
a person (from the stamps) that they 
have edited to wear appropriate clothes. 
Or they could draw a landscape with 
the weather illustrated. They might pre­
fer to just write words telling about the 
weather. Their creativity will develop as 
the year goes on! 

3. At the end of each week, print out the 
page. 

4. Bind all of the pages into a weather 
book at the end of the year. 

Weather Watch 
Temperature Time 
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Temperature Time 

Temperature Time Temperature Time 

# # 

Temperature Time 



WHERE NO HUMAN HAS GONE BEFORE 
S C I E N C E , ART, LANGUAGE ARTS 

SKILLS 
drawing 
organization 
research 
writing 

CLASS ORGANIZATION 
small group or individual 

PURPOSE 
Students learn about the solar system and 
develop research, writing, and drawing 
skills. 

PREPARATION 
Discuss the makeup of the solar system. It 
may be helpful to diagram the planets, the 
moon, and the sun on the board, keeping 
in mind their relative size and distance. 

PROCEDURE m 1. Have each student or 
group of students 
select one of the plan­
ets to research and illustrate. The stu­
dents should include in their notes its 
location, characteristics, size, rotation, 
etc. Assign one student or group to the 
sun and one to earth's moon for a fuller 
representation. 

2. Using Kid Pix 2, students should draw 
an illustration of the planet. To one side 
of the drawing they should list its most 
important features, and its name should 
be the title of the screen. 

3. Print out the planet pictures and make 
a bulletin board display for the class­
room, or for the entire school. 

4. Place all of the planet pictures into a 
slide show about the solar system. Have 
a student design a title frame for the 
report. 

EXTENSIONS 
• Using stamps, or 

drawing from scratch, 
have the students 
invent a resident of 
their planet. They can 
link the creatures to 
the planet picture 
with a description of 
what life is like on the 
planet: what and how they eat, where 
they live, how they travel. 

• Use Where in Space is Carmen Sandiego?® 
and its online data base the VAL 9000, 
Expert Astronomer™, or Discover Space™ 
to extend your students' interest in 
astronomy. 

ft 



TOTEM POLES 
G R A D E S 2 - 8 

SKILLS 
drawing 
making presentations 
organization 
research 

CLASS ORGANIZATION 
small group 

PURPOSE 
Totem poles play an important role in vari­
ous tribal cultures. This activity gives stu­
dents an opportunity to think about cul­
tures that are different from their own. 

PREPARATION 
Introduce students to totem pole carvings 
of Northwest Indian tribes, the Maori of 
New Zealand, and others. Discuss how, in 
these cultures, totem poles are carved and 
painted with a series of symbols that repre­
sent family lineage and mythical or histori­
cal incidents. Talk about how art can have 
meaning for societies beyond mere decora­
tion or beauty. 

PROCEDURE 

1. Divide the class into groups or clans. 

2. Each clan invents an identity for itself, 
including such things as animals, peo­
ple, and events important to the clan. 

3. Each group designs and creates a totem 
pole, with each student using Kid Pix 2 
to design one element of the pole—a 
sacred animal, a famous person, a 
mythical figure. Each image should be 
the size of the entire Kid Pix 2 screen. 

4. Print out the drawings using the full 
page printing option. 

5. Assemble the totems by cutting out the 
shapes and gluing them, one above the 
other, onto cardboard or construction 
paper backing. 

S O C I A L S T U D I E S , ART 

6. Each group gives an oral presentation, 
explaining the significance of each ele­
ment in the totem pole for their clan. 

EXTENSIONS 
• Students can create individual mini 

totem poles using Kid Pix 2 rubber 
stamps placed one above the other to 
represent important aspects of their 
own lives. 

• Assign groups of students to research, 
collect and display books containing 
photographs or drawings of totem poles 
from around the world. 

• The class can work together to create a 
class totem pole to display on the class­
room door. 



THEME QUILTS 

PROCEDURE 

1. If you decide to divide the class into 
groups, have each group brainstorm 
ideas for a quilt. Students may need to 
do some research first if the theme is 
unfamiliar. 

2. Have each student use Kid Pix 2 to cre­
ate one or more quilt squares. Each 
square should utilize the full Kid Pix 2 
screen. 

3. If you have a color printer available, 
encourage students to consider back­
ground colors as they design their 
squares. If your students will be color­
ing in black and white prints, color 
choices can be discussed before the 
quilt squares are colored and assembled 

4. Print each square in the largest print 
size. 

5. When the squares are finished, assem­
ble them in quilt form by gluing them 
to construction paper backing. Have 
each group give an oral presentation on 
the theme of its quilt. 

EXTENSIONS 

• The children's squares could be used as 
a basis for a fabric quilt stitched by a 
parent group. The quilt could be kept 
on display in the classroom or raffled 
off as a fund-raiser. 

M i M i 
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SKILLS 
drawing 
making presentations 
research 
visual design 

CLASS ORGANIZATION 
whole class or small group 

PURPOSE 
This activity gives students an incentive for 
doing research and provides an appealing 
alternative to a written report. 

PREPARATION 

1. Collect books on quilts to share with 
the class. Find historical examples of 
theme quilts. Discuss the current AIDS 
quilt project as an example of how a 
theme quilt has helped to heighten 
public awareness of a problem. 

2. Discuss the theme of the quilt the class 
will make. You may want to have the 
entire class work on one quilt or divide 
students into groups to make several 
quilts, all with the same theme or with 
different themes. 

3. Quilts could relate to subject matter 
being studied—such as science, history, 
myths and legends—or to social or eco­
logical concerns—such as peace or 
endangered animals. 



MAPPING 
G R A D E S 2 - 1 2 

SKILLS 
following directions 
observation 
spatial orientation 

CLASS ORGANIZATION 
individual, small group, or whole class 

PURPOSE 
Students practice mapping skills while they 
produce a variety of maps. 

PREPARATION 
1. Collect and display a variety of maps: 

highway road maps, city maps, regional 
maps, bus routes, topographical maps, 
treasure maps. 

2. As a whole class, discuss the use of 
scale, color and symbols to represent 
locations and features. 

3. Point out the convention of making the 
top of a map represent north. 

S O C I A L S T U D I E S 

a geographic area made with 
the Wacky Pencil or by using 
one of the geometric shape 
tools. This area can be designat­
ed a city, a state, or a country, 
either real or imaginary. 

map symbols made with stamps 
or other tools. 

a legend to explain the symbols 
on the map. The legend can be 
created on a separate screen. 

4. Decide whether students will follow 
written or oral instructions. 

5. Decide whether students will create a 
specific kind of map (a playground map 
or a state map, for example) or whether 
students can create any kind of map. 

PROCEDURE 

1. Give the following directions either ver­
bally or in writing. 

2. Have the students design and produce 
maps at the computer using the Kid Pix 
2 tools. The maps should include the 
following: 

• a compass marked with N , plus 
any or all of the other points. 

3. Print the maps. Have students present 
their creations and compare their maps. 

4. This activity can be repeated to experi­
ment with other kinds of maps or to 
correlate with a specific social studies 
unit. 

TIPS AND TRICKS: Consider introduc­
ing this activity by producing one map 
with volunteers and suggestions from 
the whole class, particularly if you are 
working with one computer. 

Oral instructions may work better in the 
one-computer classroom or with 
younger students. 

Individual students, small groups in a 
lab, or students selecting this activity at 
a learning center, will work more easily 
with written instructions. 



WISH YOU WERE HERE 

S O C I A L S T U D I E S , LANGUAGE ARTS, ART 

PROCEDURE 

f 

1. Show your students how to make postage 
stamps by using the Rectangle tool to 
draw a series of squares on the screen. 

2. Use Kid Pix 2 rubber stamps and other 
tools to draw pictures on the stamps. 

3. Print and cut out the stamps. 
Experiment with the print size. 

4. Create postcards using the full Kid Pix 2 
screen to draw a scene from the real or 
imaginary country. 

5. Print out and glue to stiff construction 
paper. 

6. Have the students write 
"Wish you were here...." 
messages on the post­
cards. 

7. Paste the stamps on the 
cards and "mail" them 
to other members of the 
class. 

EXTENSIONS 
• Expand the project by having students 

use a programs such as The Print Shop 
Deluxe to create other materials such as 
travel posters and newspapers from the 
real or imaginary country. 

• Students could create U.S. postage 
stamps featuring heroes or subjects that 
they think should be honored. 

TIPS AND TRICKS: To avoid wasting 
paper, make sure there is more than one 
stamp on the screen before printing. 
Several students can take turns creating 
stamps on the same screen, perhaps 
labeling their creations with their ini­
tials. Or stamps created on individual 
screens can be cut and pasted onto a 
group or class screen before printing. 

SKILLS 
desktop publishing 
research 
writing 

CLASS ORGANIZATION 
small group 

PURPOSE 
Stamps and postcards reflect many features 
of a country. This activity provides an inter­
esting focus for student research into real 
countries and can serve as a catalyst for cre­
ating imaginary countries. 

PREPARATION 

1. Discuss what stamps and postcards tell 
about a country. Ask students with 
stamp collections to brings in stamps 
showing things such as national heroes, 
animals, and monuments. 

2. Divide the class into groups. Each group 
will make stamps and postcards for a 
real or imaginary country. 

3. If students are working on a real country, 
they can divide the research, with some 
finding out about that country's heroes, 
others learning about the flora or fauna, 
or about popular tourist attractions that 
might be pictured on postcards. 

4. If students are creating an imaginary 
country, the group can brainstorm to 
come up with ideas for national heroes, 
animals, monuments and so on. 
Encourage children to give their imagi­
nations free rein. 



POLLS 

G R A D E S 3 - 1 2 

SKILLS 
comparison of data 
desktop publishing 
making presentations 
organization 

CLASS ORGANIZATION 
small group 

PURPOSE 
Students learn about designing and taking a 
poll. Then they use Kid Pix 2 as a graphing 
tool in the classroom to present the infor­
mation. 

PREPARATION 
Discuss the different polls that students see 
on TV and read about in the paper. Decide 
what information should be gathered. 
Some suggestions can include things 
around school such as how many students 
have dessert with lunch. Other topics 
could include kinds of pets. Discuss how 
helpful graphs are when polling informa­
tion is presented. Do graphs make the 
information easier to understand? 

PROCEDURE 
1. Divide the class into small groups 

2. Have each group design a poll. This 
includes what kind of questions to ask 
and how many people to poll. 

3. Have each group decide which graph­
ing method to use to present the data. 

4. Assign a time to collect the data. 

5. Have each group graph the data and 
present its finding to the class. 

PIE CHARTS 
Use the Oval tool. Hold the Shift key down 
while drawing it to make a perfect circle. 
Use the Line tool to draw the lines. Let 
your students approximate the size of the 

S O C I A L S T U D I E S , MATH 

segments for the corresponding percentages 
within reason. Don't let the difference be 
too apparent. Make sure there are no spaces 
in the lines when you fill with color. 

% of desserts ea ten a t lunch 

38% Ice Cream 
30% Fruit 
20% Cakes ii cookies 
12% No dessert 

BAR GRAPHS and PICTOCRAMS 
Use the Line tool to draw the X,Y axes. 
Then use the Rectangle tool to make the 
bars. You can copy one bar and then paste 
it multiple times. This way the bars are uni­
form. The bars can also be used to line up 
the stamps of a pictogram. 

* of 

animals 

at 

the zoo 

number at pets in tne 3rd grade 

mm 
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Kinds of animals 



CAMPAIGNS 
G R A D E S 4 - 1 2 

SKILLS 
desktop publishing 
group cooperation 
organization 
visual design 

CLASS ORGANIZATION 
small group 

PURPOSE 
Students will design campaign aids using 
Kid Pix 2. 

PREPARATION 
Discuss the process of running for a politi­
cal office with your students. Have students 
list the different kinds of materials that are 
used in campaigning: fliers, posters, cam­
paign buttons, letterhead stationary, T-
shirts, hats, banners, bumper stickers, etc. 
Also discuss the use of slogans, mascots or 
icons. These items can be designed with Kid 
Pix 2 tools. You may want to bring some 
examples to class to give the students ideas. 

PROCEDURE 
1. As a class, decide on a theme or focus 

for this campaign project. It might 
relate to a social studies or science unit 
of study, or it could connect with an 
event in a story that the whole class has 
read. 

2. Divide the class into small groups. Each 
group will organize and design materi­
als for the campaign of their candidate 
or issue. The candidates 
can be historical such as 
Lincoln and Douglas, 
issue oriented such as a 
referendum proposal on 
school construction, or 
imaginary. The issue-based or imaginary 
campaigns may work better for younger 
children who may not have historical 
knowledge of candidates. 

0̂ 

S O C I A L S T U D I E S , ART 

3. Point out that an identifying logo or 
color scheme is frequently repeated 
throughout a candidate's campaign lit­
erature. Use the blackboard to suggest 
ways a logo or slogan can be repeated 
in a variety of sizes and layouts. 

3. Have each group discuss their candidate 
or issue and design a variety of appro­
priate materials for their campaign. 

4. On "election day" have each group pre­
sent and display their candidate or 
issue, accompanying their presentation 
with their posters, buttons, etc. 

EXTENSION 

• Older students could write short cam­
paign speeches promoting their candi­
date or issue. 

• Have groups present campaign ads in a 
slide show. 
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